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IInnttrroodduuccttiioonn
Editorial guidelines and formatting standards are tools for 
ensuring consistency among paper-based documents and the 
Web sites.

Purpose and Audience
Writing Style and Standards is for the National Association of 
Parliamentarians® (NAP) leadership, committee members, and
staff who write letters, e-mails, presentations, educational 
materials, documents for Web sites, forms, dues notices, and 
other documents for internal use. It is used for guidance for 
members and staff who design and maintain the NAP Web site, 
www.parliamentarians.org. It is a guide for editorial styles, 
document organization, and page format. In addition, it is a 
training aid for new leadership, committee members, and staff.

The purpose is to ensure consistency among documents, e-
mails, and Web sites in such items as the use of the logo and
terminology. 

How to Use This Guide
This guide is not designed to be read sequentially. Feel free to 
skip around. Use it as a reference. 

Organization
Six chapters make up the style guide:  Introduction, NAP Logo, 
Elements of Style, E-mail, Appendix, and Bibliography.

Introduction

This chapter states the purpose of this guide and identifies its 
audience. In addition, it suggests how to use the guide and 
identifies the method for updating and changing the guide.

NAP Logo

This chapter describes the logo and logotype. It explains how 
and when to use each in addition to when not to use the logo 
and logotype. Consistency in the use of logos and logotypes is 
a major factor in an organization’s identity and branding.
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Elements of Style

This chapter delves into the editorial issues of writing such as 
punctuation, spelling, word usage, and capitalization. How an 
organization uses these editorial elements says a lot about an
organization; they are a part of an organization’s standards.

This chapter addresses just the most commonly made mistakes 
and sets a standard for matters where there can be more than 
one accepted spelling, punctuation, and so forth.

E-mail 

This chapter explains some of the e-mail standards and focuses 
on conveying a professional image. 

Appendix

This chapter contains such matter as illustrations on 
organization initialisms, copyright statement, and version 
numbering.

Bibliography

This chapter contains the references upon which this style 
guide is based.

Update and Maintenance Process
If you feel something should be added to or changed in this 
guide, send an e-mail to NAP’s Communication Committee.

Your e-mail message must be specific about what you feel 
needs to be changed or added and why. The reason for change 
or addition must add value. You must show this in your 
request.
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NNAAPP LLooggoo
The NAP logo and logotype graphically represent the National 
Association of Parliamentarians®. They compose our visual 
brand, and the following guidelines will help you use the logo 
and logotype appropriately in your printed and online material.

NAP Logo
The logo features a graphic of a mace on a cube with the letters 
NAP in caps inside the block. 

The mace is Pantone Reflex Blue.  Inside the cube are the 
letters NAP in bold caps in Pantone Reflex Blue.  The font is 
Arial.

Do not superimpose other words on the logo or distort the 
shape of the logo. In other words, do not change the logo.

LOGO Placement
An amount of white space should always surround the logo.

Other text or graphics should not occupy this white space. Use 
your best judgment when inserting the logo into your document 
or web page.
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NAP Logotype
The NAP logotype is the organization name appearing in small 
caps in Times New Roman typeface. The logotype is designed 
to be used alone.

Logotype Construction

The following are procedures for constructing the logotype.

Step Action Results

1 Type the words in initial 
case.

National Association of 
Parliamentarians®

2 Highlight the words. National Association of 
Parliamentarians®

3 On the Format menu, click 
Fonts.

The Font dialog box 
appears.

4 In the Font dialog box, click 
the Font tab and the Small 
caps checkbox. Click OK.

NATIONAL 

ASSOCIATION OF 

PARLIAMENTARIANS®

5 Highlight ®. ®

6 In the Font dialog box, click 
the Font tab and the 
Superscript checkbox. 
Click OK.

NATIONAL 

ASSOCIATION OF 

PARLIAMENTARIANS
®

NATIONAL ASSOCIATION OF PARLIAMENTARIANS
®
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Logotype Placement

The logotype is designed to be used in text.

When to Use Logo and Logotype

Use the logo or logotype or both on all NAP material,
especially the following:

 Stationery.  All official stationery and stationery items of 
NAP.

 Publications.  Magazine, brochures, pamphlets, 
educational materials, miscellaneous communications, and 
forms.

 Web sites.  All Internet and intranet sites.

Association or Unit use of Logo

All active associations and units are permitted to combine the 
NAP logo with a graphic of their state/province or similar 
characteristic in order to design a logo that represents that they 
are a division of NAP. The NAP logo should never be 
distorted. Any misuse of the NAP logo will not be tolerated.

When Not to Use Logo and Logotype

 Never use the logo and logotype on personal stationery or
on any publication or document not officially sanctioned by 
NAP. The NAP logo is a connecting link between NAP’s 
operations and members and the public, and its use on 
personal documents may give the false impression that 
NAP has approved or monitored these documents.

 Do not use the logo and logotype on personal Web sites. If 
members wish to promote membership with NAP, he or she 
may spell out the organization name, which may also be 
used on Web sites as a link to the NAP home page.

 The logo and logotype should not appear in ads, literature, 
or other communications that promote, or include the 
promotion of, products or services of others without written 
permission.
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Logo Colors

 The use and consistency of NAP’s colors are important 
parts of our identity.

 The logo and logotype are Pantone Reflex Blue. No other 
colors may be used in the logo and logotype. In a one-color 
logo, white and black can be used.

 The four-color process equivalent to Pantone® Reflex Blue 
is 100% Cyan combined with 72% Magenta and 6% Black 
with 0% Yellow. 

 When designing web sites, the hexadecimal equivalent of 
Pantone Reflex Blue is #00209F. 
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EElleemmeennttss ooff SSttyyllee
The editorial styles and notational conventions are based on 
recommendations from the following sources and from 
research of writing practices:

 The Chicago Manual of Style

 Microsoft Manual of Style for Technical Publications

General Style Conventions
This section addresses editorial styles and notational 
conventions that affect paper-based documents and web pages.

Abbreviations

The following are rules of usage concerning abbreviations:

 Use abbreviations in tables, notes, bibliographies, and lists.

 Words of one syllable should not be abbreviated.

 The name of an organization should be written out in full 
the first time it is used in an article; thereafter it can be 
abbreviated. 

 Use periods after lower case abbreviations (no. and mo.).

 Use a period and a space after initials for personal names 
(J. J. Wales).

 In an abbreviation with an internal period there should be 
no space after the internal period (Ph.D.).

 Always abbreviate Dr., Mr., Mrs., and Ms.

 Mr., Mrs., Ms., and Dr. are always dropped if another title 
is used (John Wilson, Ph.D.).

 In quoting from bylaws the words “article” and “section” 
are spelled out the first time they are used and abbreviated 
thereafter. For example: 

ARTICLE III. The members of the organization shall be…

ART. IV. The officers shall be…

SECTION 1. The bylaws committee shall…

SEC. 7. The finance committee shall…
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Active vs. Passive Voice

In general, use the active voice, which tells who or what is 
performing the action. For example, “NAP implements a new 
program every quarter” instead of “A new program will be 
implemented by NAP every quarter.”

Affect vs. Effect

Affect is normally used as a verb meaning “to influence, 
change, assume.” Effect can be either a verb meaning “to bring 
about” or a noun meaning “result, impression.” For example,

 The court’s decision in this case will not affect (change) the 
established legal precedent.

 She affects (assumes) an unsophisticated manner.

 It is essential that we effect (bring about) an immediate 
improvement in sales.

 It will be months before we can assess the full effect
(result) of the new law.

All Caps

Avoid using all caps (Example:  ALL CAPS), which is viewed 
as shouting at the reader. In addition, research shows it affects 
reading comprehension.

Between vs. Among

Between should be used when discussing being in the middle of 
two items, and among should be used when discussing being in 
the middle of three or more items.

Bold

Make the following bold:

 Button titles. For example,

خ Press the Cancel button.

 Window titles. For example,

خ In Oracle, select Batch Sheets in the AP Batch and 
Vendor Control window.

 User input. For example,
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خ Type 1 in the quantity field.

 Menu names. For example,

خ Select Edit on the menu bar.

 Commands on menus and options. For example,

خ The Copy command duplicates and distributes the 
material.

خ Click New on the File menu.

Dialog box titles and options. For example,

خ Click Close in the Information dialog box.

Note In addition, use bold to show emphasis.

Do not

 Make field names bold; instead capitalize field names.

 Make keys bold; instead use small caps.

 Use bold as a verb.

Buttons

Refer to buttons by title in procedures, as in “click Close” 
instead of “click the Close button.”

Cannot vs. Can Not

Use cannot—the correct spelling.

Capitalization

Use capitalization with caution. Do not over capitalize. 
Capitalize the following:

 Proper nouns (Missouri, Jane Smith, Florida Alpha 
Parliamentarians Unit)

 The first word of a sentence or an expression standing as a 
sentence

 The first word of a bulleted item
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 Titles of honor or academic, professional, and business 
titles when listed with a proper name (President 
Washington; General Robert; Susan Johnson, Professional 
Registered Parliamentarian)

 Official names of national or international governmental 
bodies or documents (Charter of the United Nations)

 Name of congresses, councils, organizations, and 
institutions (National Association of Parliamentarians)

 Field names 

 The names of functional elements in software interface 
such as toolbars (the Standard toolbar) and toolbar buttons 
(the Insert Table button)

 Internet

 Web, World Wide Web, and Web site

 All words with four or more letters in titles and headings. 
Also capitalize words with fewer than four letters except:

خ ARTICLES:  the, a, an

خ SHORT CONJUNCTIONS: and, as, but, if, or, nor

خ SHORT PREPOSITIONS:  at, by, for in, of, off, on, out, to, 
up

Do not capitalize

 Common nouns and verbs that derive from proper nouns. 
For example,

خ Did you xerox this page?
but
Do you work for Xerox?

خ I own an IBM Personal Computer III.
but
Last Sunday I bought a personal computer.

 The word intranet. If the intranet has an official name and 
“intranet” is part of the name, capitalize. For example, 

خ The document is posted on the intranet.

خ The document is posted on NAP’s intranet.

خ The document is posted on the NAP Intranet (if this is 
the official name of the intranet).
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 Software interface elements used generically such as 
toolbar, menu, scroll bar, and icon.

 The word federal.

 The word social security number.
but
The Social Security Administration.

Click vs. Click On

Use click to describe the user’s action of choosing or selecting 
a command or option. Do not use click on although it is 
acceptable to “click in the window.”

When you must click once, use click; when you must click 
twice, use double-click. Do not use click twice or click two 
times.

Colons

A colon is used to introduce a formal direct quotation, a direct 
quotation, or a direct question. For example, Robert:  “Where 
there is no law, but every man does what is right in his own 
eyes, there is the least of liberty.”

A colon can be used to introduce a listing, generally after “the 
following.”

Use a colon after the salutation business letters. For example, 
Dear Sirs:  or Madame President:.

Insert two spaces after a colon.

Commas

Do not overuse commas. A comma does not always precede 
the word and.

Use a comma 

 To separate three or more elements in a series including the 
element before and or or. For example, “He dropped the 
ball, bat, and glove on the ground.”

 To set off nonessential expressions that interrupt the flow 
of thought from subject to verb to object or complement. 
For example, “There is, no doubt, a reasonable explanation 
for his behavior at the board meeting.” (You do not need no 
doubt to complete the meaning of the sentence; it is 
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nonessential.)
but
There is no doubt about her honesty. (Without no doubt, the 
structure of the sentence would be incomplete; it is 
essential.)

 Before a coordinating conjunction (and, but, or, or nor) in 
a compound sentence that joins two independent clauses 
(each clause has a subject and a predicate). For example,

خ “Either we step up our promotion efforts, or we must be 
content with our existing market share.”

Do not confuse a compound sentence with a simple 
sentence that contains a compound predicate. For 
example, 

“Mary is going to town and will stop by the bank.”

 Note the use of commas with the expression of dates in the 
following examples.

خ On August 13, 2000, Mary and John received a bank 
loan that permitted them to purchase a new car.

خ The Third Quarter 2006 issue of the National 
Parliamentarian carried an informative article on scope 
of notice.

Compose vs. Comprise

Compose means to create or to make up. Comprise means to 
include or to contain. 

Dashes

Use an em dash (—) to indicate an abrupt change. For 
example, “Don’t believe him—ever!”

Use an en dash to indicate a span (a range). For example, “You 
will find the information on pages 20–23.”

Note Do not use a hyphen (-) to indicate a span.

Do not use a space before or after an en dash, an em 
dash, or a hyphen.

We is the 
subject and 
step is the 
verb of the 
first clause.

We is the 
subject and 
must be is the 
verb of the 
first clause.

Mary is the 
subject and is 
going and will 
stop is a 
compound 
predicate.
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Dates

Express dates in the following manner:

 When the day precedes the month, express it in ordinal 
figures (1st, 2nd, 3rd, and so forth). For example, “This 
year’s conference runs from Monday, the 2nd of August, 
through Thursday, the 5th.”

 When the day follows the month, use a cardinal figure (1, 
2, 3, and so forth.). For example, “Florida is holding a 
special election on March 6.”

 Express complete dates in month-day-year sequence. For 
example, February 21, 2007.

Display vs. Appears

Use display as a transitive verb only, as in “The screen displays 
the program.” Use appears as an intransitive verb as in “The 
dialog box appears.”

Each vs. Every

Use each to refer to individual items of a group as in “Give 
each member a ballot.” Use every to refer to a group of
individual items as in “Every member received a ballot.”

E-mail vs. Email

Hyphenate e-mail.

Emphasis

Don’t overemphasize. Use bold to denote emphasis when 
necessary as in caution, not CAUTION.”

Ensure vs. Insure

Ensure means to make certain or to imply a guarantee. The use 
of insure is restricted to providing or obtaining insurance to 
indemnify or guarantee someone or something against loss. 

Etc.

See Latin Abbreviations.
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Fax vs. FAX

Use fax—the abbreviation for facsimile, not FAX.

Federal

Capitalize federal only when it is part of the official name of a 
federal agency, a federal act, or some other proper noun. For 
example,

 The Federal Reserve Board meets on Thursday.

 We are subject to federal, state, and local laws.

Fields

Do not bold field names; capitalize them. For example, 
“Complete the Name field.” not “Complete the Name field.”

File Name vs. Filename

Write file name not filename.

Fonts

Use Times New Roman for text and Verdana for headings. 
Font type and size are established in template styles for paper-
based documents. 

Use Verdana exclusively on the Web.

Forms

Capitalize form names. For example, Form 941, Employer’s 
Federal Quarterly Tax Return.

Gender Reference

Avoid using he/she or s/he; use he or she. Additionally, do not 
use they as a singular pronoun. For example, write “the user,” 
“the system administrator,” or “enter your logon name.”

Hyphens

Words are usually hyphenated when:

 Two or more words are combined to form a compound 
adjective.
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 The second element is capitalized or thought of as 
representing something official or institutional. For 
example, anti-American or ex-Governor.

 Containing three or more words and a prepositional phrase. 
For example, behind-the-scenes, heart-to-heart, or attorney-
at-law.

 The first element is self. For example, self-determination, 
self-starter.

 The same letter occurs three times in succession. For 
example, bell-like, cross-stitch.

 A vowel would be confusingly doubled in combination. 
For example, co-owner.

 They contain numerals and fractions used as adjectives. For 
example, a two-thirds vote, but two thirds of those present.

 Using “elect” with a name of office unless the name of 
office is two or more words. For example, president-elect, 
treasurer-elect, city tax collector elect.

In vs. Into

Use in to imply a position within. For example, “The 
correspondence is in the file.”

Use into to imply entry or change of form. For example, “He 
walked into the outer office.”
but
Mr. Wilson came in to see me. (In is part of the verb phrase 
came in; to is part of the infinitive to see.)

Initialism

An initialism is an abbreviation made up of the initial letters of 
the components of the full form of a designation or from 
syllables of the full form, and pronounced letter by letter. Use 
abbreviations sparingly. Spell out the complete term the first 
time an abbreviation or initialism appears, and then show the 
abbreviation or initialism in parentheses. For example,

 NATIONAL ASSOCIATION OF PARLIAMENTARIANS
® (NAP)  

A list of NAP initialisms are in the Appendix.
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Italics

Use italics to indicate the name of a complete work. For 
example, “The styles and standards for NAP’s paper-based 
documents and Web sites are in NAP’s style guide, Writing 
Style and Standards.”

Its vs. It’s

Use its when you are showing possession. For example, “The 
corporation must protect its assets.”

Use it’s when you mean it is. For example, “It’s time to take 
stock of our achievements.”

Keyboard Key Names

Use small caps on text representing a key on the keyboard. For 
example, TAB, ENTER, M, and ESC. 

The following are procedures for constructing the small-cap 
effect for keyboard key names.

Step Action Results

1 Type the name of the key in lowercase. tab

2 Highlight the name of the key. tab

3 On the Format menu, click Fonts. The 
Font
dialog 
box 
appears.

4 In the Font dialog box, click the Font tab 
and the Small caps checkbox.

TAB

Do not bold key names or enclose them in brackets.

Write “Press ENTER,” not “Press the ENTER key.”

Key-Stroke Combinations

Use a plus sign to indicate key combinations such as shortcut 
keys and access keys. For example, write ALT+O if the user 
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needs to press and hold down ALT and then press O. Note that 
the plus sign is in small caps along with the key names. Do not 
enclose key names in brackets.

Latin Abbreviations

Avoid using Latin abbreviations such as etc., i.e., and e.g. in 
running text. Use similar expressions like and so forth, and so 
on, such as, and for example.

Latin abbreviation usage is acceptable in lists, tables, and 
parenthetical series.

Lists

We use two types of lists: bulleted lists and numbered lists. 

Bulleted Lists.  Use a bulleted list for an unordered series of 
concepts, items, or options rather than a sequence of events or 
steps. The order of a bulleted list is not important:

 Introduce the bulleted list with a sentence or fragment 
ending with a colon.

 Bullet each item in the list.

 Begin each item in the bulleted list with a capital letter.

 End the bulleted list item with a period if it is a complete 
sentence or completes a sentence.

 Construct bulleted lists to be parallel in structure; that is, 
begin each one with the same part of speech such as an 
infinitive, verb, or preposition.

Example:

The database owner can:

خ Create and delete a database.

خ Add, delete, or modify a document.

خ Add, delete, or modify any information in the database.

Numbered Lists.  Use a numbered list for procedures or 
sequential lists (the order is important): 

 Number each procedure sequentially.

 Introduce a procedure with an infinitive phrase or 
imperative.
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 Capitalize the first word of each procedure.

Example:

To log on to a database:

1. On the File menu, click Open Database.

2. In the User Name box, type your name.

3. In the Password box, type your password.

4. Click OK.

Log On To, Log Off, Logon

Use log on to when referring to connecting to a network and 
log off (not log off from) when referring to disconnecting from 
a network. Do not use log in, login, log onto, log off of, logout, 
sign off, or sign on.

Example:

 You are prompted for your password while logging on.

 Remember to log off the network.

 Reconnect when you log on to the network.
but

 Some networks support this logon feature.

Use logon only as an adjective, as in “logon password,” not as 
a noun. For example, it is incorrect to say, “You are prompted 
for your password during logon.”

Numbers and Figures

Use numbers and figures as follows:

 Spell out numbers from one through ninety-nine and any of 
these followed by: hundred, thousand, million, and so forth.

 Use figures for 100 and larger sums.

 Avoid beginning a sentence with figures; numbers at the 
beginning of a sentence should be spelled out. If this is 
cumbersome, rewrite the sentence.

 Use figures in tables, directions for construction, and to 
express degrees in temperature.



WWrriittiinngg SSttyyllee aanndd SSttaannddaarrddss EElleemmeennttss ooff SSttyyllee

NATIONAL ASSOCIATION OF PARLIAMENTARIANS® Page 19
Version 1.0 2007

 Approximations used in place of exact figures are spelled 
out. For example, two thousand members at the convention 
or three hundred people attended the seminar.

 Common fractions should be spelled out. For example, a 
two-thirds vote is required to amend the bylaws.

 Quantities containing whole numbers and fractions should 
be expressed in figures. For example, 8 ½ -by 11-inch 
paper.

 Times of the day are spelled out in text, but use figures to 
emphasize the exact moment. For example, the first 
meeting of the convention was held on Saturday at nine 
o’clock; be sure to attend the meeting on bylaws at 2:00.

Online, On-line, On Line

Use as one word (online) in all instances whether used as an 
adjective or an adverb.

Parallelism

Construct headings and bulleted lists so they are parallel in 
structure; that is, each beginning with a verb, gerund, infinitive,
and so forth. 

Percent

Avoid using % in text; spell percent except when presenting 
statistical or technical information in tables or charts.

Periods (Spacing After)

Use one space after a period. This includes a person’s initials.
but
Do not space when using P.O. for post office and U.S. for 
United States.

Prescribe vs. Proscribe

Use prescribe to recommend something. Use proscribe to 
forbid it.
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Previous/Following vs. Above/Below

To avoid confusion when referring to graphics or illustrations 
that may move inadvertently from one page to another, avoid 
using above and below. Use previous and following.

Quotation Marks

Periods and commas are always inside a closing quotation 
mark; colons and semicolons stand outside quotes.

Quotation marks are not used when the quotes material is set in 
smaller or different type.

Refer To vs. Refer Back To

Use refer to. For example, “Refer to your book for additional 
information.”

Report Names

Present report names with initial caps; do not bold or italicize. 
For example, “Run the Financial Report before tomorrow’s 
meeting.” Do not capitalize “report” unless it is included in the 
report’s title.

See vs. Go To

Use see for referring to figures, lists, and references. For 
example, “See List 12 for names of committee members.”

Use go to when a step is continued elsewhere in the procedure. 
For example, “If the sum of the numbers is not 100, go to
step 5.”

Sign Off vs. Sign-off

Use sign off and sign-off to refer to getting approval. For 
example,

 Will you sign off (verb) on this proposal?

 We finally received the last sign-off (noun) we needed to 
move ahead on this project.
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Telephone Numbers 

Now that all local numbers require use of the area code, do not 
put the area code in parentheses. Instead, simply use a second 
hyphen: 303-735-1079. For extension numbers, use: Ext. 2, 
Ext. 364, Ext. 4071.

They’re vs. Their vs. There

Be sure to distinguish between words that sound the same but 
have different meanings. For example, there are contractions 
and possessives that sound the same (they’re and their) but 
have different meanings.

 There’re is a contraction meaning there are. There’re 20 of 
us going on a picnic.

 Their is a possessive pronoun (shows ownership). Fire 
damaged their house.

 When there is used as a function word to introduce a 
sentence or clause, it is a pronoun. There shall come a time 
when we will realize how important it is to learn 
technology.

Note If the two words that make up the contraction make 
sense in the sentence, then you can use the contraction 
in the sentence. For example,

 You’re dress is red.  
(You are dress is red.) The contraction is 
incorrect—use your, the possessive pronoun. 

Type vs. Enter

Use type, not type in or enter, if information the user types will 
appear on the screen. An exception to this rule is that you can 
tell users to enter a file name (e.g., in a combo box when they 
have the choice of typing a name or selecting one from a list). 
For example,

 Type your password.

 Enter the file name.
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Use vs. Utilize

Use use when you mean to put into action or to consume. For 
example, “Use your spare time to learn more about the real-
estate industry.”

Use utilize when you mean using something in a way in which 
it was not meant to be used.” For example, “Many homemakers 
utilize vegetable peelings in compost piles.”

Vice-President vs. Vice President

Hyphenate vice-president.

Which vs. That

Use that to introduce restrictive clauses. Restrictive clauses are 
essential for the sentence to make sense. Commas do not 
separate restrictive clauses. For example, “The garage that my 
uncle built is falling down.”

Use which to introduce nonrestrictive clauses. Nonrestrictive 
clauses are not essential to the meaning of the sentence. 
Commas are used to separate nonrestrictive clauses. For 
example, “John’s car, which is red, is a Mustang.”

Who vs. That

Use who and that when referring to persons.

Use who when the person or the individuality of a group is 
meant. For example, “She is the only one of my managers who
can speak Spanish fluently.”

Use that when a class, species, or type is meant. For example, 
“He is the kind of student that should take advanced math.”

Window vs. Screen

Generally, use window to refer to levels of graphic display in a 
program. Use screen to refer to the graphic portion of a 
monitor. For example,

 Double-click the Word icon on the screen.

 The screen displays the Word program.

 The Document window appears.

 Click File, Close to exit the Document window.
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EE--mmaaiill

We use e-mail for much of our correspondence; therefore, it is 
important to implement e-mail standards focused on conveying 
a professional image, promoting efficiency, and protecting the 
corporation from liability.

Creating E-mail Signatures 

Each e-mail will contain the following standard signature 
information:

Name
Title
NATIONAL ASSOCIATION OF PARLIAMENTARIANS

®

Telephone number, extension
Fax number
E-mail address
Web address

For example,

Sarah Nieft
Executive Director
NATIONAL ASSOCIATION OF PARLIAMENTARIANS

®

Phone:
Fax: 

sarah@nap.org
www.parliamentarians.org

E-mail Do’s and Don’ts

Follow these guidelines when writing an e-mail:

Do Do Not

Use a meaningful subject. Write in CAPITALS. It is 
looked upon as shouting and 
is rude.

Be concise and to the point. Forward chain letters.
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Do Do Not

Use proper spelling, 
grammar, capitalization, and 
punctuation.

Forward virus hoaxes.

Use short paragraphs and a 
blank line between each 
paragraph. 

Reply to spam.

Use short sentences. Send or forward e-mails 
containing libelous, 
defamatory, offensive, 
racist, or obscene remarks or 
pornographic material.

When making points, number 
or bullet them.

Copy another person’s 
message or attachment 
without permission.

Use active voice instead of 
passive.

Use e-mail to discuss 
confidential information.

Respond to e-mails swiftly. Send a message when you 
are angry.

Use Arial 12pt for all 
messages.

Note:  In Outlook, on the 
Tools menu, select Options, 
Compose, Font Settings.

Use “reply all” unless all 
need to see your reply.

Take care with abbreviations 
and emoticons.

Copy all individuals whose
name you use in an e-mail.

As a courtesy, copy a person 
whose area of responsibility 
you are discussing.

Carefully read all e-mails 
before you click Send.
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Although e-mail is considered an informal method of 
communication, your writing skills are reflective of your 
knowledge and abilities.

Because a person cannot see your face or read your body 
language when corresponding via e-mail, emoticons can be 
useful especially if you are trying to convey a feeling. Just be 
careful and not overuse them.
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AAppppeennddiixx
The appendix contains reference information you may find 
useful.

Initialisms

Below is a list of NAP initialisms. 

NAP Initialisms

Initialism Complete Form

NAP National Association of Parliamentarians

NP National Parliamentarian

NTC National Training Conference

PDC Professional Development Course

PQC Professional Qualifying Course

PRP Professional Registered Parliamentarian

RO Robert’s Rules of Order (1st, 2nd, and 
3rd editions) 

ROR Robert’s Rules of Order Revised (4th, 
5th, and 6th editions)

RONR Robert’s Rules of Order Newly Revised
(7th, 8th, 9th, and 10th editions)

RP Registered Parliamentarian
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NAP Copyright Statement

NAP’s copyright statement is as follows:

 Copyright © year by NATIONAL ASSOCIATION OF 

PARLIAMENTARIANS
®. All rights reserved.

Year indicates the year the document was first produced. 
Additional years indicate the year of each subsequent edition. 
Multiple subsequent years are concatenated with an en dash. In 
addition, the version number changes.

Example:  A document that was produced in January 2002 and 
updated in March 2003 the copyright statement would read:

 Copyright © 2002–2003 by NATIONAL ASSOCIATION OF 

PARLIAMENTARIANS
®. All rights reserved.

Version Numbering

Whenever a minor or major change is made to a document, the 
version number changes. Indicate a minor change by adding a 
.01, .02, and so forth. Indicate a major change by changing to 
whole number.

Example 1:  A publication is produced in February 2005 and is
updated in September 2005. It is a minor update. The version 
number and copyright statement read as follows:

Version 1.01
Copyright © 2005 by NATIONAL ASSOCIATION OF 

PARLIAMENTARIANS
®. All rights reserved.

Example 2:  A publication is produced in January 2006 and is
updated in November 2006. It is a major update. The version 
number and copyright statement read as follows:

Version 2.0
Copyright © 2006 by NATIONAL ASSOCIATION OF 

PARLIAMENTARIANS
®. All rights reserved.

Example 3:   A publication is produced in May 2005 and is 
updated in March 2006. It is a major update. The version 
number and copyright statement read as follows:

Version 3.0
Copyright © 2005–2006 by NATIONAL ASSOCIATION OF 

PARLIAMENTARIANS
®. All rights reserved.
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